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End Users License Agreement 

 

NOTICE TO USER: 

THIS IS A CONTRACT. PLEASE READ IT CAREFULLY. BY INSTALLING THIS SOFTWARE OR DOWNLOADING THE 
ASSOCIATED INSTALLATION FILE YOU ACCEPT ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO 
NOT AGREE WITH THE TERMS AND CONDITIONS OF THIS AGREEMENT, YOU WILL NOT BE ABLE TO USE THE SOFTWARE. 
 
REGARDLESS OF HOW YOU ACQUIRE THE SOFTWARE (ELECTRONICALLY, PRELOADED, ON MEDIA OR OTHERWISE), BY 
USING IT YOU AGREE TO THE TERMS OF THIS AGREEMENT. 
 
This William K. Warburton dba X-ray Instrumentation Associates (“XIA”) End-User License Agreement (“Agreement”) sets forth the terms and 
conditions under which you are licensed to use the Software. Software means (A) all of the contents of the disk(s), CD-ROMS(s), or other media 
with which this agreement is provided, including but not limited to (i) XIA or third-party software; (ii) related explanatory written materials 
(“Documentation”); and (B) modified versions, upgrades, updates, additions, and copies of the Software, if any, licensed to you by XIA 
(collectively, “Updates”). XIA grants to you a nonexclusive license to use the Software, provided that you agree to the following: 
 

1. Use of the Software 

(i) The term “Permitted Number of Computers” means the number of computers for which you have purchased or been 
granted licenses by XIA.  

(ii) You may install one copy of the Software onto a hard disk or other storage device of up to the Permitted Number of 
Computers. 

(iii) You may install one copy of the Software on a single file server for the purpose of downloading and installing the 
Software onto a hard disk or other storage device of up to the Permitted Number of Computers that are on the same 
network as the file server. No other network use is permitted. 

(iv) You may make one backup copy of the Software, provided your backup copy is not installed or used on any 
computer. You must reproduce the copyright notice(s) on such copy of the Software. 

 

2. Restrictions 

(i) You may not copy, transfer, rent, modify, use or merge the Software, or the associated documentation, in whole or in 
part, except as expressly permitted in the Agreement. 

(ii) You may not reverse assemble, decompile, or otherwise reverse engineer the Software. 
(iii) You may not remove any proprietary, copyright, trade secret or warning legend from the Software or any 

Documentation. 
(iv) You may not modify, sell, rent, transfer (except temporarily in the event of a computer malfunction), resell for profit, 

or distribute this license or the Software, or create derivative works based on the Software, or any part thereof or any 
interest therein. 

3. Copyright 

The software and any copies that are owned by XIA, and its structure, organization, and code are the valuable trade secrets of XIA. The Software 
is also protected by United States Copyright Law and International Treaty Provisions. You must treat the Software just as would any other 
copyrighted material, such as a book. You may not copy the Software, except as set forth in the “Use of the Software” section. Any copies that 
you are permitted to make pursuant to this Agreement must contain the same copyright and other proprietary notices that appear on or in the 
Software. You agree not to modify, adapt or translate the Software. You also agree not to reverse engineer, decompile, disassemble, or otherwise 
attempt to discover the source code of the Software. Trademarks shall be used in accordance with accepted trademark practice, including 
identification of trademark owners’ names. Trademarks can only be used to identify printed output produced by the Software and such use does 
not grant you any rights of ownership in that trademark. Except as stated above, this Agreement does not grant you and intellectual property 
rights in the Software. This Agreement provides the terms and conditions under which you are licensed to use the Software. It is not an agreement 
for the sale of the Software to you. 
 

4. DISCLAIMER OF WARRANTIES 

XIA MAKES NO WARRANTIES, EXPRESS, IMPLIED, OR STATUTORY, AS TO ANY OTHER MATTERS, INCLUDING BUT NOT 
LIMITED TO NON-INFRINGEMENT OF THIRD-PARTY RIGHTS, MERCHANTABILITY, OR FITNESS FOR ANY PARTICULAR 
PURPOSE. XIA DOES NOT AND CANNOT WARRANT THE PERFORMANCE OR RESULTS YOU MAY OBTAIN BY USING THE 
SOFTWARE. 
 
Some states or jurisdictions do not allow the exclusion of implied warranties or limitations on how long an implied warranty may last, so the 
above limitations may not apply to you. To the extent permissible, any implied warranties are limited to ninety (90) days. 
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5. Limitation of Liability 

IN NO EVENT WILL XIA BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INDIRECT, INCIDENTAL, PUNITIVE, OR SPECIAL 
DAMAGES, INCLUDING ANY LOST PROFITS OR LOST SAVINGS, EVEN IF A REPRESENTATIVE OF XIA HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY THIRD PARTY. 
 
Some states or jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations may not 
apply to you. 
 

6. Governing Law and General Provisions 

This Agreement will be governed by the laws in force in the State of California excluding the application of its conflicts of law rules. This 
Agreement will not be governed by the United Nations Convention on Contracts for the International Sale of Goods, the application of which is 
expressly excluded. If any part of this Agreement is found void and unenforceable, it will not affect the validity of the balance of the Agreement, 
which shall remain valid and enforceable according to its terms. You agree that the Software will not be shipped, transferred, or exported into any 
country or used in any manner prohibited by the United States Export Administration Act or any other export laws, restrictions, or regulations. 
This Agreement shall automatically terminate upon failure by you to comply with its terms, in which event you must destroy all copies of the 
Software. This Agreement may only be modified by a writing signed by an authorized officer of XIA, although XIA may vary the terms of this 
Agreement in connection with the licensing of any Updates to you. 
 

7. Notice to U.S. Government End Users 

The Software and Documentation are “Commercial Items”, as that term is defined at 48 C.F.R. 2.101, consisting of “Commercial Computer 
Software” and “Commercial Computer Software Documentation”, as such terms are used in 48 C.F.R. 12.212 or 48 C.F.R. 227.7202 as 
applicable. Consistent with 48 C.F.R. 12.212 or 48 C.F.R. 227-7202-1 through 227.7202-4, as applicable, the Commercial Computer Software 
and Commercial Computer Software Documentation are being licensed to U.S. Government end users (A) only as Commercial Items and (B) 
with only those rights as are granted to all other end users pursuant to the terms and conditions herein. Unpublished-rights reserved under the 
copyright laws of the United States. XIA, 8450 Central Ave, Newark, CA 94560. 
 

8. Verification of Compliance with Licenses 

If you are a business or organization, you agree that upon request of XIA or XIA’s authorized representative, you will within thirty (30) days 
fully document and certify that your use of any and all XIA software at the time of the request is in conformity with your valid licenses from 
XIA. 
 

9. Sample Programs 

The Software may contain sample programs that are furnished by XIA as examples. These examples have not been thoroughly tested under all 
conditions. XIA, therefore, cannot guarantee or imply reliability, serviceability, or function of these sample programs. You may copy, modify, 
and distribute these sample programs in any form without payment to XIA, for the purposes of developing, using, marketing and distributing 
application programs conforming to the application programming interface for the operating platform for which the sample programs are written, 
provided that: 
 

• You agree to defend, hold harmless and indemnify XIA from and against any and all claims, liabilities, damages, expenses and costs 
arising out of or in connection with your use or distribution of the sample programs, modifications thereof, or your application 
program(s); and 

• You do not state that XIA certifies or guarantees the operation of the sample programs or modifications thereof, with any hardware 
and/or software. Each copy or partial copy of the sample programs, or any modifications thereof, must include a copyright notice as 
follows: 

 
Copyright (c) [year] [your company name] 
 
Portions of this code are derived from XIA Sample Programs. 
 
Copyright (c) XIA. All rights reserved. 
 
These sample programs may require additional software to operate. The right to redistribute a sample program does not include the right to 
redistribute software that is a prerequisite for its operation. In particular, your right to redistribute a sample program does not include the 
right to redistribute the Software. 
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1 Introduction  

The Kepler program provides four basic abilities: 
1) configure an X-Ray Instrumentation Associate’s (XIA) spectroscopy 

module; 
• Dynamically configure XIA spectroscopy modules 
• Configure XIA modules via save files (INI files) 
• Save your interface setup 
• Transparent operation from one session to another 

2) acquire data using the module and 3rd party detector; and 
• User settable run times (4 different stop conditions controlled by the 

module) 
• Dynamic control of runs (you can start and stop runs at will) 
• Display data as it is acquired by the module at settable rates 
• Resume previous runs without losing spectrum data 

3) analyze spectrum data; 
• Scale energy measurement to match known spectral lines 
• Dynamic regions of interest (ROI) controls 
• Gaussian fits to ROIs 
• Panning and zooming to examine spectrum features 
• Linear and logarithmic displays 
• Save and load spectra 

4) diagnose problems with any detector setup. 
• Digital oscilloscope and fast fourier transform (FFT) mode 
• Track baseline measurements 
• Directly edit DSP variables running on the module 
• Monitor and control the error reporting between the host computer and 

the module 

Kepler allows you to configure a module using either built-in panels or 
configuration (INI) files.  There are multiple, built-in tools that aid you in 
debugging both detector and the module problems.  You can acquire data from 
the module in one of several modes; both fixed length and indeterminate runs 
are supported.  Once a spectrum has been acquired with the XIA module, Kepler 
allows you to perform some simple analysis on the spectrum, e.g. peak fitting, 
ROIs. 
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1.1 Manual Conventions 

The following terms will be mentioned throughout the manual 

Convention Description  Example 
» The » symbol leads you through nested menu items, 

DAQExplorer items, and dialog box options. 
The sequence  
File»Page Setup»Options directs you to 
pull down the File menu, select the Page 
Setup item, and choose Options from the 
sub menu item. 

Bold Bold text denotes items that you must select or click 
on in the software, such as menu items, and dialog 
box options. Bold text also denotes parameter names. 

Saturn»Run Control»Auto Update… 
(this doesn’t seem to be clickable, per se) 
indicates the entry starting with Auto 
Update in the Run Control section of the 
Saturn section of the DAQExplorer. 

[Bold] Bold text within [] denotes a command button. [Start Run] indicates the command 
button labeled Start Run. 

monospace Items in this font denote text or characters that you 
enter from the keyboard, sections of code, file 
contents, and syntax examples.  This font is also used 
for the proper names of disk drives, paths, 
directories, programs, subprograms, subroutines, 
device names, functions, operations, variables, and 
filenames and extensions. 

Setup.exe refers to a file called 
“setup.exe” on the host computer.  
Examples of the other items? 

“window” Text in quotation refers to window titles. “Options” indicates the window accessed 
via Tools»Options. 

Italics Italic text denotes variables, emphasis, a cross-
reference, or introduction to a key concept. This font 
also denotes text that is a placeholder for a word or 
value that you must supply. 

Mondays are always the worst day of the 
week. 

<Shift> Angle brackets denote a key on the keybord (not case 
sensitive).  

<W> indicates the W key 

<Shift-Alt-
Delete> or  
<Ctrl+D> 

A hyphen or plus between two or more key names 
denotes that the keys should be pressed 
simultaneously (not case sensitive). 

<Ctrl+W> represents holding the control 
key while pressing the W key on the 
keyboard 

Bold italic Bold italics denotes a warning or caution statement Beware of small green men means to 
watch out for aliens. 
Beware of salesmen bearing gifts means 
what it says. 

• DAQExplorer – refers to the tree of information and options along the left side of the 
“Kepler” main window 

• module – refers to an XIA spectroscopy module 
• host computer – refers to the computer on which Kepler is running 

 
Additional terms may be found in the Glossary 

1.2 Related documentation 

The following documents are sources of additional information while 
operating your XIA hardware.  All documents can be downloaded in the 
Portable Document Format (PDF) from XIA's Internet site www.xia.com. In 
order to request printed copies, please send an e-mail to support@xia.com, or 
call the company directly. 

 
Kepler Hardware Manual 
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Kepler Application Notes 
Kepler Quickstart Guide 
Handel Guide 

1.3 Hardware Requirements 

1.3.1 Supported Spectroscopy Modules 

1.3.1.1 Saturn X-ray Spectrometer 

Kepler supports the XIA Saturn digital x-ray processor in both its reset 
and RC feedback preamplifier designs. 

The host computer running Kepler should have only a single Saturn 
connected at any time.  

1.3.1.2 Polaris Gamma-ray Spectrometer 

Kepler will support the XIA Polaris digital γ-ray processor soon.  
Please check XIA’s website for release information. 

1.3.2 System Requirements 

The host computer that runs Kepler must have the following minimum 
capabilities: 
• 300 MHz or greater processor speed running most Microsoft Windows 

Operating systems (95, 98, Me, 2000, NT, XP) 
• Enhanced Parallel Port (EPP) capabilities.  This must be confirmed and set 

in the BIOS settings of the computer.  Anything but full EPP support will 
not be sufficient to control the Saturn module.  Note: most computers 
support EPP but may not have their BIOS settings configured for the 
operation, booting to the BIOS and double checking this setting is 
important. 

• XIA recommends an EPP certified cable.  Most EPP cables have been 
found to work, but we only guarantee operation with an EPP certified cable 
(obtainable from XIA or most computer stores). 

1.4 Support 
By Mail:  Attn: Support 

X-ray Instrumentation Associates 
8450 Central Ave.  
Newark, CA 94560 USA 

 
By e-mail:  software_support@xia.com 
 
By phone: (510) 494-9020 
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2 General Kepler 

2.1 Installation 
 

1) Insert the CD into the CD-ROM drive.   If the installation does not start 
automatically follow steps 2 & 3. 

2) Click the Start button and select the Run command. 
3) Type X:\Setup.exe and click OK.  Remember to replace the 'X' with 

the proper drive letter for the CD player on your computer. 
4) Enter the information as requested to indicate where to install KEPLER or 

click OK to accept the defaults. The Default stores the Handel DLLs in the 

2.

5/6
Valid for Windows 95, 
98, ME, NT, XP and 
2000
C:\Windows\System (C:\Winnt\System32 for NT based operating 
systems) folder, and the Kepler software, in C:\Program 
Files\XIA\Kepler. 

 
When returned to the Desktop, the installation is complete. 

2 Getting Around Kepler 

Getting around Kepler requires basic knowledge of the Windows 
operating environment.  If you are unfamiliar with any of the following 
terminology (i.e., ‘clicking’ and ‘drop down list box’) refer to your Windows 
manual for more details. 

2.2.1 Selecting Items and Moving Around Windows 

DAQExplorer – This area is located to the left of the main Kepler window and 
provides the main way to navigate through the Kepler application.  To access 
more items click the small + sign to expand a feature heading and display more 
options.  Click the small – sign to reverse the process. 

Cursor statistics are only 
shown when a cursor is 
active on a graph.  

Display Controls– This area is located on either the lower or upper edge of all 
graphs within Kepler and determines the default behavior of the graph window..  
Settings in this region determine the functionality of the mouse in the display 
region and how to represent the graph.  The right hand side of the display bar 
provides cursor statistics (when they are active). 

The action performed by 
a left click of the mouse 
is determined by the 
default mode shown on 
the far left of the graph 
display bar. 

 
Menu Bar– The menu bar provides a secondary access point to most major 
functions and windows within Kepler. 
 
The various windows and functions of Kepler can be selected in three different 
ways. 
 
Hot Keys – Each menu, menu selection, function, and most fields contain a hot 
letter (a letter in the word that is underlined).  To access menus, functions, and 
fields, press and hold the Alt key and then press the item’s Hot Key.  To access 
menu items simply press the Hot Key. 
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Mouse – Single clicking on any menu, menu selection, or function will give you 
access to that item.  In addition, single clicking in any window field will select 
that field for editing. 
Keyboard – To select a menu press ALT and use the left and right arrow keys to 
highlight menus and press Enter, or the down arrow key, to open menus.  Use 
the up and down arrow keys to highlight menu selections and press Enter to 
select. 

Once inside a function window, the Tab key can be used to move 
forward between fields and Shift-Tab to move backwards through the fields.  
(Press and hold the Shift key and then press the Tab key while still holding the 
Shift key down.)  NOTE:  Pressing Enter inside a function window will save 
any changes and exit the function. 

2.2.2 Window Tabs 

Several windows in Kepler have tab sections (e.g., expert 
configuration, expert acquisition values and options).  These tabs look similar to 
manila file folder tabs (found in most filing cabinets).  These tabs provide access 
to different sections for entering information and can be selected by the same 
methods mentioned above:  Hot Keys, mouse, and keyboard (Tab/Shift-Tab). 

2.3 Hardware Setup 

2.3.1 Saturn Setup 
The quick start guide in 
the hardware manual is 
the best place to 
successfully start using 
Kepler. 

Please refer to the Saturn hardware manual provided by XIA for details 
on setting up your Saturn module. 

2.3.2 Polaris Setup 

When Kepler support for Polaris becomes available, you should refer to 
the Polaris hardware manual provided by XIA for details on setting up your 
Polaris module. 

 

2.4 Starting and Stopping Kepler 

There are two ways to quickly get Kepler running: 
• Double click the Kepler Icon on your desktop 
• Choose Kepler from Start»programs»Kepler»Kepler.  

After installation, Kepler, by default, is located in 
“C:\Program Files\XIA\Kepler” or whatever location was chosen during 
installation.  Within the installation directory are located two directories that 
contain files to help you get started for the first time.  The “firmware” directory 
will contain a file called “saturn.fdd” which contains the firmware (programs 
downloaded to the Saturn module).  The “config” directory will contain 
“saturn_std.ini” which is a simple initialization file that works with most 
detector setups.  Fine-tuning of the setup parameters can occur after Kepler is 
running. 

Kepler maintains a 
persistent state across 
sessions.  The state is 
saved when Kepler is 
closed and restored when
it is open. 
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Figure 1: Overview of Kepler.  This figure shows all the main elements of the Kepler program with labels for the 
important areas of the control interface. 
A shortcut for Kepler should have been created on the Desktop of your 
windows operating system.  In addition, there should be a Start menu item for 
running and uninstalling Kepler.  Each time Kepler is run, it will attempt to 
resume operation in the same configuration as the last time it ran.  This includes 
both the window positions for the Kepler program as well as the hardware 
configuration of any XIA module.  Some aspects of these configurations can be 
controlled in the Tools»Options menu item within Kepler (see §2.6). 

After starting Kepler, you should see a window that looks like Figure 1, 
which also labels some of the more important parts of the program.  Most 
command operations are controlled through the DAQExplorer or with menu 
items.  Kepler always shows the spectrum window with its associated regions of 
interest and display controls.  The statistics from the most recent run (or most 
recently loaded spectrum) are shown at the top of the screen.  The current 
program status is shown at the bottom of the screen with the status indicators. 

2.5  Kepler save files 

A Kepler configuration file can be saved to disk at any time.  The 
Kepler (*.kep) configuration files maintain all Kepler settings related to the 
graphical user interface (GUI), which include window positions and state 
(minimized, maximized or normal), run parameters, display parameters, graph 
states, etc…  These save files allow customized windows for each type of 
analysis being performed, but do not include the settings required to configure 
any XIA module.  The hardware configuration related to setting acquisition 

Note the difference 
between a .kep file, 
which saves Kepler 
configuration and an .ini 
file, which saves the 
module configuration.  
You can save either or 
both. 
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values (see §4.1) and related quantities on the Saturn itself are contained in an 
initialization (INI) file (see §3.1). 

2.6 Tools»Options Settings 

The Options panel contains global settings that affect the entire 
program.  The “configuration” panel contains settings that dictate how Kepler 
initially starts.  The “graphics” panel contains settings that affect the operation 
of the various graphs within Kepler. 

 
The “configuration” panel contains the following settings: 
• Default Kepler Save File – location of the GUI configuration file used at 

Kepler startup 
• Default Hardware Save File – location of the INI file used to configure a 

module at Kepler startup 
• Default Error File – location of the Error file generated during Kepler 

operation, this should be send to XIA along with any error reports 
• Automatically Initialize Hardware – this checkbox controls whether a 

module connected to the host computer is automatically configured using 
the Default Hardware Save File at program startup 

 
The “graphics” panel contains the following settings: 
• Zoom Enable Key – controls the hotkey used to perform zooming in graph 

windows (<hotkey-left mouse button>)  
• ROI Setting Key – controls the hotkey used to create ROIs within the 

spectrum window (<hotkey-left mouse button>) 

2.7 Help Displays 

If confused about the 
action of a control in 
Kepler, check the help 
bar on the lower edge of 
the Kepler window, it 
might answer your 
question. 

The panel at the lower edge of the Kepler window contains some 
detailed context sensitive help for many controls.  This Help Display changes 
depending on where the mouse is located. When the mouse is not over a control 
within Kepler, the Help Display shows information about Kepler’s current 
running state (run active, unconfigured hardware, etc…). 

 

2.8 Status Display 

In addition to the help display, the lower panel shows some general 
status messages for Kepler.  In general, if the Status Display shows a red square, 
then something is wrong; if it’s green then Kepler is running properly.  A list 
and brief description of the panel items follows: The status display can 

give you a quick 
overview of the state of 
Kepler, e.g. if a run is 
active, if the system is 
configured, what save 
files are in use. 

• Type – if green, shows the current configured board type; if red, there is no 
valid hardware configuration. 

• Configured – if green, then the hardware is configured; if red, the hardware 
is unconfigured. 

• Run Active – if green, then a data-taking run is active; if red, no data-
taking run is active (Note: this is a red indicator that is not indicating a 
problem with the system). 
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• Save File – if green, displays the last (either saved or loaded) hardware 
configuration file (INI); if red, indicates that the current configuration has 
never been saved or loaded. 

• GUI Save File – if green, indicates that the Kepler GUI configuration 
(window placement, etc…) has been saved and the name of the file is 
displayed; if red, then the GUI configuration has never been saved. 

2.9 Menus 

There are drop-down menus at the top of the Kepler window for most 
operations.  When in doubt on how to perform a particular action, check the 
menus at the top of the Kepler window. 
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3 Configurations: Saving, Loading and 
Restarting 

3.1 INI files 

The standard file used to maintain hardware configurations for Kepler 
is called the INI file.  This file contains all settings relevant to data taking setup 
and all firmware pointers for the XIA module.  The INI file is read and written 
using the Handel library and the format is beyond the scope of this document.  
All settings contained in this file are accessible via Handel and you should never 
need to modify the file directly.  For more information about INI file, please 
refer to the Handel documentation. 

INI files save the 
hardware configuration 
of the module. 

3.2 Firmware Definition Database (FDD) files 

All XIA modules have a digital signal processor (DSP) and field 
programmable gate arrays (FPGAs) that must be configured any time the 
module loses power.  XIA distributes the configurations in files called firmware 
definition database (FDD) files, which contain all the configuration data for both 
DSP and FPGAs on the modules.  The files are ASCII, but should not be edited 

3.

5/6
FDD files contain 
firmware information 
(DSP and FPGAs 
programs) and are 
distributed by XIA. 
except by XIA personnel.  The details of the format are beyond the scope of this 
document. 

3 Preamplifier Parameters 

The parameters discussed here are important during the initial 
configuration of the module.  A more detailed description is provided in the 
quick start guide located in your hardware manual.  See the sidebar for a picture 
of the section of the DAQExplorer that is used to change the preamplifier 
parameters. 

3.3.1 Preamplifier Gain 
Saturn»Run Control»Preamplifier Gain =… 
 
The preamplifier 
section of the 
DAQExplorer. 
The preamplifier gain is a measure of the voltage gain of the 
preamplifier for signals generated by the detector.  For Kepler, this value must 
be measured in millivolts of preamplifier signal per keV of x-ray energy 
(mV/keV). 

3.3.2 Preamplifier Polarity 
Saturn»Run Control»Preamplifier has X Polarity 

The output of the preamplifier will produce either an upward or a 
downward voltage pulse in response to an event in the detector.  Kepler refers to 
pulses that move upward as positive, while downward pulses are negative. 
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3.3.3 Preamplifier Type 

All XIA modules support both reset and RC feedback preamplifier 
type.  This setting can be changed at any time but does require new firmware to 
be downloaded and a jumper to be changed on the module.  If needed, please 
review your hardware manual for details. 

3.3.4 Reset Interval 
Saturn»Run Control»Reset Interval =… 

When using a preamplifier with a reset circuit, the output signal can 
briefly contain non-linear components following each reset.  If the module 
processes these signals, the resulting energy measurements will be wrong.  All 
XIA modules allow a settling time after a reset is detected, which is defined by 
the Reset Interval.  During this settling time, the module does not process any 
signals from the detector and this time is not counted as live time (see §4.6.2).  
Improper setting of the reset interval can drastically affect the energy resolution 
of some detector setups.  For further information, please review this concept in 
the hardware manual. 

Valid for detectors with 
reset preamplifiers only 

3.3.5 Decay Time 
Saturn»Run Control»Decay Time =… 

When using a preamplifier of the RC feedback type, the signal 
generated by the preamplifier rises by some amount (dependent on the incident 
energy) then slowly decays exponentially with a RC time constant set by the 
value of the resistor in parallel with the preamplifier’s charge integrating 
capacitor.  The RC decay time of this resistor-capacitor combination determines 
how quickly the signal from the preamplifier will return to its baseline value.  In 
order to perform ballistic deficit corrections, the module must know this 
parameter.  The accuracy of setting this parameter can drastically affect the 
energy resolution of some detector setups.  Please review this concept in the 
hardware manual if it is new to you. 

Valid for detectors with 
RC feedback 
preamplifiers only 

3.4 Troubleshooting problems setting the initial gain 

 

3.5 Configuration methods 

There are two ways to configure a system using Kepler; either load an 
INI file or enter the information regarding configuration individually.  Once you 
have an INI file, you can load it and the settings will be applied to the hardware 
module.  The other option is to enter all the necessary information into a 
configuration panel and have Kepler apply the information to the module.  The 
easiest method is to use the INI files that are distributed by XIA and bootstrap 
your way to the correct settings using the functions described in §3.3 and §4.1.  
As changes are made to the settings, an INI file should be saved and updated 
until you have the desired settings in place. 

3.5.1 Loading an INI file 
File I/O»Load INI File 

 

Simply loading an INI 
file is the quickest 
method of configuring a 
module. 
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Configuration»Load INI File 
<F4> 

Using any of the options above opens a dialog box that allows the 
selection of an INI file to load from disk.  All settings will be automatically 
applied to the module. 

3.5.2 General Configuration 
Right Click on Saturn/Configure and select INI File Organizer or select 

Detector Preamplifier Configuration 
Configure»INI File Organizer or Detector Preamplifier Configuration 
<Ctrl+C> or <Ctrl+I> 

The general configuration panel consists of a tabbed panel window 
with two tabs as shown in Figure 2.  One tab contains the INI File Organizer, 
which presents a simple file view of INI files for the currently selected directory.  
The other panel shows the Detector Preamplifier Configuration panel that 
allows direct input of all parameters required to get the module up and running. 

The INI preview box is 
read-only.  Editing of the 
INI file directly will be 
available in a future 
versions of Kepler. 

The INI File Organizer tab contains two large boxes: the one on the 
left is a list of INI files in the current working directory, while the right shows 
the contents of the INI file that was last selected with the mouse from the left 
box (this box is read-only).  Using the file selector box just above the INI file 
box, you can change the current working directory for the INI file box, which is 

5

      
Figure 2: The panel on the left shows the INI file organizer and on the right is the detector preamplifier 
configuration panel.  Right clicking on configure/[module type] and selecting either the INI file organizer 
or detector preamplifier configuration will access these panels. 
displayed on the lower left of the panel; all INI files in the selected directory 
will be added to the left box and the selected file will be shown in the right box.  
Double clicking on an INI filename will download the settings in the INI file to 
the hardware module. 

Double click on an INI 
file to download settings 
to the hardware module. 

If an INI file is not desired, then the Detector Preamplifier 
Configuration tab is the place where all relevant information for configuration 
is entered.  Note:  an INI file contains all the information represented in this 
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panel so this panel is an alternative method for configuration.  Unless modified 
by you, this panel reflects the data used in the last successful configuration of a 
module (not necessarily the information contained in the currently selected INI 
file or on the module!).  Most of these parameters are discussed in §3.3, please 
refer to the hardware manual quick start guide for a detailed description of all 
these parameters. 

When all the information is input in the panel, pressing the [OK] or 
[Apply] button at the bottom of the configuration window will configure the 
system (the [OK] button will also close the expert configuration panel).  If at 
any time while changing the configuration settings you wish to undo the 
changes, press the [Cancel] button.  After the settings are final and you you 
have successfully configured the module using the [Apply] button, the 
configuration can be saved to an INI file by pressing the [Save to INI] button. 
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4 Taking Data with Kepler 

4.1 Acquisition Values 

The values discussed in this section directly affect the data acquired 
with the XIA module.  The hardware manual for the specific XIA module you 
are using should be referenced for detailed descriptions of these values.  The 
information provided here is only intended as a refresher or brief introduction.  
Within Kepler, the values can be modified from the two DAQExplorer sections 
shown in the sidebar to the left. 

4.1.1 Peaking Time 
Saturn»Acquisition Settings»Peaking Time =… 
Saturn»Run Control»Peaking Time =… 

5/6
 
The general acquisition 
settings section of the 
DAQExplorer. 
In order to determine the energy of pulses from the preamplifier, the 
spectroscopy module time averages the pulses using a trapezoidal shaping filter 
that is characterized by a peaking time and a gap time.  The filter’s peaking time 
determines the amount of averaging performed when determining the energy of 
a signal from the detector.  Setting the peaking time to larger values typically 
will improve your energy resolution up to a point.  However, longer peaking 
times also increase dead times, directly reducing the maximum count rates at 
which you can effectively acquire data.  This trade off is important but beyond 
 
The baseline settings 
section of the 
DAQExplorer. 
the scope of this document.  Peaking time is probably the single most important 
quantity for most applications, so please review the description provided in your 
XIA hardware manual if you need to learn more. Peaking and gap time 

are Digital filter 
parameters used by all 
XIA modules; the 
peaking time is 
approximately equal to 
twice the shaping time of 
an analog amplifier, 
while the gap time is 
analogous to a rise time 
setting. 

4.1.2 Gap Time 
Saturn»Acquisition Settings»Gap Time =… 

The trapezoidal filter’s gap time allows the filter to be insensitive to the 
risetime characteristics of the preamplifier output pulses.  The gap time should 
therefore always be set larger than the longest rise time of the pulses from the 
detector preamplifier.  In principle, the gap time should be barely larger (50 ns) 
than the maximum rise time to maximize the throughput of data into a spectrum.  
Because of limitations of the firmware on XIA modules, it is not always possible 
to set the gap time exactly to the desired value (depending on the peaking time 
setting).  Kepler will always remember your desired value and attempt to set that 
value each time the peaking time is changed.  Kepler will also report the value 
that is actually set on the module (labeled as Actual =). 

4.1.3 Spectrum Bin Width 
Saturn»Acquisition Settings»Spectrum Bin Width =… 

The spectrum bin width represents the size in energy (eV) of each bin 
in the spectrum display.  The full energy range (dynamic range) of the displayed 
spectrum is therefore the spectrum bin width times the number of spectrum bins.  
The module will also keep track of the number of valid events that were 
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acquired but fell outside this energy range, counting them as either underflows 
or overflows. 

4.1.4 Spectrum Bins Saturn modules allow 
any number of spectrum 
bins from 1 to 8192. 

Saturn»Acquisition Settings»Spectrum Bins =… 

The spectrum bins selects the number of bins in the spectrum display. 

4.1.5 Trigger Threshold 
Saturn»Acquisition Settings»Trigger Threshold =… 

The trigger threshold shows the amplitude (in energy units) required for 
a pulse from the detector to generate a trigger and initiate the process of 
measuring the pulse’s energy (see the hardware manual for more details on this 
process).  It is important to watch for a noise peak appearing at very low 
energies; if the noise peak is too big (comparable to any peak of interest), then 
the threshold should be raised till the noise peak is either small or entirely gone. 

A noise peak at low 
energies in the spectrum 
is undesirable.  The most 
common way to remove 
the peak is to increase 
the trigger threshold. 

4.1.6 Energy Threshold 
Saturn»Acquisition Settings»Energy Threshold =… 

The energy threshold is used for detecting very low energy X-rays.  
Similar to the trigger threshold, this threshold enables the measurement of the 
energy of the pulse from the detector, but operates with much lower noise.  X-
rays with energies below 200 eV can be analyzed with the proper detector, 
setup, and configuration of the Saturn module. 

Saturn specific 
capability! 

4.1.7 Baseline Cut 
Saturn»Baseline Settings»Baseline Cut =… 

The baseline cut removes 
outliers that would 
adversely affect the 
baseline average.  The 
trigger algorithm does 
not detect these events. 

In order to properly measure the energy of a pulse from the detector, 
the module continuously tracks the baseline value of the preamplifier output.  
The module allows a cut to be applied that determines if a baseline is good 
enough to contribute to the average baseline or an outlier to be excluded (see the 
hardware manual for more details).  This cut is determined by moving out along 
the tails of the baseline histogram (see §7.2) until the histogram is down a 
percentage from its peak.  The percentage used in this method is set by the 
baseline cut value in Kepler.  This cut can also be enabled and disabled using 
Saturn»Baseline Settings»Baseline Cut is…. 

4.1.8 Baseline Filter Length 
Depending on the type of 
noise in the system, a 
bigger filter length might 
improve energy 
resolutions. 

Saturn»Baseline Settings»Baseline Filter Length =… 

The baselines for the module are averaged as an infinite impulse 
response (IIR) digital filter.  The value used in calculating the energy of a pulse 
from the detector uses the output of this IIR filter.  The effective length of the 
IIR is set with the baseline filter length setting.  Up to a point, increasing the 
number in the average reduces the noise in the baseline average, the point being 
determined by the amount of low frequency noise in the preamplifier output.  
Experimentation is usually required to determine the best value for a particular 
detector/preamplifier setup. 

4.1.9 Expert Settings 
Right click on: 
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Saturn»Acquisition Settings 
Saturn»Baseline Settings 

For more advanced settings, Kepler provides the “system settings” 
window shown in Figure 3.  All the values described in §4.1 are available for 
editing in this window along with some more advanced settings: calibration 
energy, ADC percent rule, trigger peaking time, trigger gap time and enable veto 
(gate). 

5

Figure 3: The expert settings window accessed within Kepler.  This is a central location for all acquisition 
settings as well as a few settings not recommended for the timid user. 
4.1.9.1 Calibration Energy 

In conjunction with the ADC percent rule, Calibration Energy 
determines the module’s gain setting.  Typically a calibration peak is used from 
a radioactive source, which has a spectral line near the energy range of interest 
to your measurement, e.g. 55Fe has a spectral line at 5.9 keV.  For purposes of 
setting the module’s initial gain, set the Calibration Energy to the energy of the 
line you intend to use for energy calibration (e.g. 5.9 keV). Calibration energy and 

ADC percent rule set the 
gain of the module. 4.1.9.2 ADC Percent Rule 

The ADC percent rule is used in conjunction with the calibration 
energy to determine the modules initial gain.  Depending upon the gain, a 
“typical” pulse from the detector will use a certain percentage of the ADC’s 
measurement range in the module - this is the ADC percent rule.  For reset 
detectors, this is typically set to 5%; for RC feedback detectors it is set to 40%.  
The Setup Wizard initially uses these standard values. 

4.1.9.3 Trigger Peaking Time 

In order to detect a pulse from the detector, the module utilizes a trigger 
based on a fast digital filter, referred to as the trigger filter.  The trigger filter‘s 
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response time is determined by setting its peaking time - the shorter the trigger 
peaking time, the faster the response and the more accurate the measurement of 
the pulse start time, which in turn directly improves the energy measurement for 
that pulse.  However, there is a tradeoff between the speed of the digital filter 
and its ability to reject noise when detecting pulses - the longer the trigger 
peaking time, the greater the ability to avoid noise triggers.  Typically, the 
Saturn performs well with a trigger peaking time of 100 ns; there should be no 
need to change this setting. 

The trigger algorithm is 
based on a digital filter 
similar to the energy 
measurement filter.  The 
peaking and gap times 
for the trigger filter 
determine its efficacy. 

4.1.9.4 Trigger Gap Time 

This parameter helps the trigger filter with noise immunity; please read 
§4.1.9.3 for more details.  Typically, the Saturn performs well with a trigger gap 
time of 0 ns; there should be no need to change this setting. 

4.2 Starting and Stopping Runs 
Saturn»Run Control»Start Run 
Saturn»Run Control»Stop Run 

 
The buttons (left) and 
DAQExplorer (right) entries 
for starting and stopping runs. 

Run Control»Start Run 
Run Control»Stop Run 
[Start Run] 
[Stop Run] 
<F4> 

A data acquisition run can be started using several methods within 
Kepler, two of which are shown in the sidebar.  Once the run is started, it can be 
stopped using the same control (or any of the other methods).  The text on the 
control should change to indicate the status of the control. 

The methods to control run starts and stops are: 

1) Single clicking the entry in the DAQExplorer, Saturn»Run Control»Start 
Run with the left mouse button. 

2) Using the menu item: Run Control»Start Run, which can be accessed by 
either left clicking on the menu item or using the hotkey <F4>. 

3) Using the button located on the upper left corner of the spectrum display to 
start or stop a run. 

When a run is started, the y-axis scale mode for the spectrum display 
(see §5.4) is set to fixed auto scale, which will keep the spectrum in full view 
while data is being acquired.  This mode does not apply to the x-axis, allowing 
x-axis zooming to view a particular portion of the spectrum.  After the run is 
completed (stopped either by you or by Kepler), Kepler restores the y-axis scale 

4.

5/6
Only the y-axis scale 
mode is automatically 
changed during data 
collection.
3 Ways to Start/Stop a 
Run 
1) DAQExplorer entry 

(under Run Control) 
2) Menu item (under 

Run Control) 
3) Button above the 

spectrum 
mode that existed prior to the run. 

Sections 4.3, 4.5, 4.6, and 4.7 discuss more controls in Kepler related to 
data acquisition management. 

3 Resuming a run 
Saturn»Run Control»Clear Spectrum at Run Start 

 
Two methods to set the 
next run to be resumed. 

Saturn»Run Control»Retain Spectrum at Run Start 
“Kepler”»Run Control»Resume Run 
<Ctrl+R> 
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At every run start, the spectrum memory and statistics from the last run 
can either be cleared or retained.  If cleared, the statistics are reset to zero and 
the spectrum memory is emptied.  If retained, then the new run picks up where 
the last run stopped.  Resuming a run after changing any acquisition settings is 
generally not recommended.  Stop the run then start anew.  Two of the methods 
to set the resume run status are shown in the sidebar. 

Resuming a run after any 
change in module 
settings will not produce 
reliable results. 

4.4 Update Interval 
Saturn»Run Control»Auto Update… 

After a run is started, Kepler can periodically update the spectrum 
display with the most recent data stored on the module.  This is very useful for 
monitoring the success or failure of the current run, allowing the operator to 
make adjustments as needed.  The interval between spectrum updates can be set 
with the DAQExplorer entry (see the sidebar), Saturn»Run Control»Auto 
Update….  Simply click on the entry and choose an update interval.  The 

 

4

5

The run control section of the 
DAQExplorer. 
module itself limits the minimum auto update rate (readout time is typically less 
than 10 ms).  If auto update is disabled, then Kepler will only read out the 
spectrum when the run is stopped either by you or by the module. Auto update varies the 

interval used to 
continuously readout 
module data (spectrum 
and statistics). 

Once each update, Kepler performs two important functions to keep 
itself synchronized with the module.  First, if auto update is enabled for any time 
interval, then Kepler also reads the statistical information (see §4.6) about the 
run in addition to the spectrum.  Second, Kepler will also check if the run has 
been stopped for any reason by the module.  If so, Kepler will update its own 
display appropriately, including reading out the spectrum and statistical 
information one final time. If auto update is 

disabled, Kepler still 
checks if the run is 
finished every second. 

If auto update is disabled, Kepler will still monitor the run status once 
every second, an action that does not require reading the spectrum or statistical 
information and requires less than 1 ms of the host computers time (does not 
affect data taking at all). 

.5 Run Types and Times 
Saturn»Run Control»Run to… 
Saturn»Run Control»Run Time =… 
Saturn»Run Control»Run Events =… 

Kepler supports five different modes for data collection.  Select the 
desired mode by clicking on the DAQExplorer entry (see the sidebar of §4.4), 
Saturn»Run Control»Run to….  The length of the run will be determined by 
the setting of Saturn»Run Control»Run Time =… or Saturn»Run 
Control»Run Events =…, depending upon the run type selected.  At any time, 
you can interrupt the run by stopping the run in one of the ways described in 
§4.2.  The five modes of operation are described below. 

Five data collection 
modes are supported: 
one is infinite, the other 
four are preset. 

4.5.1 User Intervention 

This mode programs the module to run indefinitely.  The only way to 
stop this run is by user intervention, i.e. using Kepler to stop the current run.  
For this mode, the setting of Saturn»Run Control»Run Time =… does not 
influence the length of the run. 
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4.5.2 Preset Runs 

4.5.2.1 Stop Control Value 

Some runs end after a set 
time, others after a set 
number of events are 
collected. 

Each of the four preset modes will automatically stop when the run 
type stop condition is satisfied.  The stop conditions are either time based or 
event based depending on the run type selected.  The time stop condition is set 
in the DAQExplorer through the entry, Saturn»Run Control»Run Time =…, 
while the event based stop condition is set in the DAQExplorer entry 
Saturn»Run Control»Run Events =…. 

4.5.2.2 The Four Preset Modes 

The four preset modes are: 
• Preset Real Time – run until a preset real time expires.  Please see §4.6.1 

for an explanation of real time in this context. The module 
automatically stops 
preset runs.  Kepler will 
detect that the run has 
stopped and update the 
display appropriately. 

• Preset Live Time – run until a preset live time expires.  Please see §4.6.2 
for an explanation of live time in this context. 

• Preset Input Counts – run until a preset number of input counts are 
acquired.  Please see §4.6.3 for an explanation of input counts. 

• Preset Output Counts – run until a preset number of output counts are 
acquired.  Please see §4.6.4 for an explanation of output counts. 

4.5.2.3 Stop Accuracy 

Because of the design of XIA’s spectroscopy modules, Kepler cannot 
stop runs with perfect precision.  Time stopped runs may exceed the desired run 
time by up to 1.6 ms, while event stopped runs may exceed the requested 
number of events by up to 1.6 ms times the event rate, where the event rate is 
ICR or OCR depending on the run type.  In all cases, Kepler will detect that the 
run is over as soon as the next auto update time expires and will change its status 
accordingly (just as if you had hit the stop run button).  If more accurate, sub-
microsecond, stop times are required, this can be achieved using the module’s 
external Gate input.  Please contact XIA directly for details. 

The gate input can be 
used for precise run 
control operations.  If 
this is a concern for your 
experiment, please 
contact XIA for more 
information. 

4.5.3 Run Time/Run Events 
Saturn»Run Control»Run Time =… 
Saturn»Run Control»Run Events =… 

As discussed above, this entry in the DAQExplorer determines either 
the amount of time or the number of acquired events that will cause the module 
to automatically end the run.  The DAQExplorer display will change 
automatically to accommodate the run type chosen in Saturn»Run 
Control»Run to…, and you can select either one of the pre-defined choices or 
enter your own custom value by clicking on the Saturn»Run Control»Run 
Time =… or Saturn»Run Control»Run Events =…. 

 

4.6  Run Related Statistical Information 

The statistics of the run (event rates, times, etc…) are updated every 
time Kepler reads out spectrum data from the module, shown in Figure 4.  This 
can occur automatically, during an auto update cycle, or be forced by pressing 
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the [Refresh] button.  The following statistics are displayed in a bar at the top of 
the spectrum display. 

4.6.1 Real Time 

The real time is the total time elapsed during a data acquisition run. 

4.6.2 Live Time 

The live time is the total time that the module was sensitive to 
incoming pulses.  The live time will always be less than the real time and 

5/6
Many factors can affect 
the ratio of live to real 
time.  Please review the 
hardware manual if this 
is a concern. 
Figure 4: The run statistics bar in Kepler.  This bar shows a summary of run statistics, updated 
automatically at the end of all runs and at the user defined update interval.  The statistics can also be 
updated by pressing the [Refresh] button. 
depends on many factors - the interplay between input count rate and peaking 
time being the dominant effect.  Please read the hardware manual for more 
details about how your module measures live time.  

4.6.3 Input Count Rate (ICR) 
ICR is the rate of events 
detected by the trigger 
algorithm. 

The input count rate is the rate of events being detected by the 
module’s trigger algorithm.  Each time the trigger algorithm in the module 
detects an event the total number of input counts for the run is incremented.  The 
ICR is calculated in Kepler by dividing the total number of input counts by the 
live time. 

4.6.4 Output Count Rate (OCR) ) 
OCR is the rate of events 
added to the spectrum. The output count rate is the rate of good (non-piled up) events being 

detected by the module.  These events may either be written into the spectrum 
memory or counted as overflows and underflows if their reconstructed energies 
lie outside of the spectrum limits as determined by the number of histogram bins 
(§4.1.4) and the spectrum bin width (§4.1.3).  The OCR is calculated in Kepler 
by dividing the total number of good events by the real time for the run. 

4.6.5 Dead Time Percentage 

The dead time is a measure of the fraction of time when the module 
was not sensitive to input data (displayed in percent) and has three sources.  At 
significant count rates, dead time is dominated by the time required to measure 
the energies of the pulses (a minimum of twice the peaking time plus the gap 
time per pulse: see sections 4.1.1 and 4.1.2).  The other sources are the recovery 
time required per preamplifier reset (see §3.3.3) and times the module’s 
processor must spend on minor housekeeping functions.  Because of the latter 
two terms, there will always be a small amount of dead time, even when the 
input count rate is very small, and the peaking times is small as well.  Kepler 
calculates the dead time percentage as (1 – ICR/OCR) * 100. 

Dead time percentage is 
the fraction of time the 
module is not sensitive to 
incoming events. 
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4.7 Unavailable functions while a run is active 

While a data acquisition run is active there are numerous functions that 
are locked out since they would interfere with the proper operation of the 
module.  The functions listed below either will not respond while the run is 
active or their button/menu items will be grayed out indicating that they are 
unavailable. 

Some functions are not 
available when the run is 
active.  Kepler will not 
let you change things 
that will affect data 
taking that is in progress.

• All items under Saturn»Acquisition Settings 
• All items under Saturn»Detector Settings  
• All items under Saturn»Baseline Settings 
• Saturn»Run Control»Peaking Time =… 
• Saturn»Run Control»Run Time =… 
• Saturn»Run Control»Run to… 
• Saturn»Run Control»Clear Spectrum at Run Start or its alternate value 

of Saturn»Run Control»Retain Spectrum at Run Start 
• Diagnostics»Oscilloscope»Acquire Trace or the button [Acquire Trace] 

on the “Oscilloscope” window 
• Writing any DSP parameters in the “DSP Parameters” window 
• [Calibrate] button in the ROI region of the “Kepler” window 
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5 Graph usage in Kepler 

5

5

Figure 5: A typical spectrum with important controls labeled.  The controls are discussed in detail in the 
text. 

All graphs within Kepler have the same zooming, panning, scaling, and 
data presentation tools.  A typical spectrum graph view is shown in Figure 5, 
please refer to it as you read the section in Chapter 5.  All graphs in Kepler also 

have the ability to save and overlay references from memory, allowing easy 
comparisons between past and present data.  However, only the spectrum 
display in the “Kepler” window allows detailed analysis of ROIs. 

The control menus that 
appear when you right-
click on the graph axes 
are different from those 
that appear when you 
right-click on the main 
plotting area. 

There are two methods to access all the settings described below: 
1) through the series of drop down list boxes in the upper or lower left 

(depending on the graph) corner of the graph display; or 
2) by right clicking on the graph itself and using the drop down menus that 

appear.  Different drop down menus are available on the axes and the main 
graph area, but all should be self-explanatory. 

.1 Default Modes 

In the graph display bar, the first drop down box on the left lets you set 
the default mode.  The chosen default mode defines how the graph will act when 
the left mouse button is pressed on the graph window (in combination with no 
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other keys).  The choices are Zoom, Pan and None for most graphs, while the 
spectrum window has the additional option for Create ROI.  Each of these 
options is described in more detail below.  If None is selected, then no action is 
performed when the left mouse button is pressed. 

5.2 Zooming 

There are two main methods to zooming in on a feature of the graph.  
The first method of zooming uses the main graph display and the mouse to 
directly expand the view.  The second zooming method utilizes a small inset 
window that is called the “mini-zoom” window located in the upper right corner 
of all graph displays.  This window shows the full graph area with an inset white 
box that shows the current view area being displayed by the main graph.  
Changing the size and location of the white box within the “mini-zoom” 
window, produces zooming and panning in the main graph window.  Both 
methods are described in the following sections. 

At any time, the view of the full graph can be returned by either 
<Ctrl+A> or using the right click menu option within the graph Full Scale.  
Restoration of the full graph display is a very useful way to ‘return to reality’ if 
you have zoomed into a small region and forget where you are in the full graph 
display.  However unlikely, should a bug in the Kepler program make it 
impossible to continue zooming or panning, using Full Scale will restore the 
graph display to normality. 

When problems are 
encountered while 
zooming or panning, 
<Ctrl+A> can be very 
useful for recovering. 

5.2.1 Main Window Zooming 

The following description applies when the graph is set to Zoom as the 
default mode or when the zoom hotkey is pressed (set in the “Options” window) 
at the same time as the left mouse button. 

The most common method of zooming is clicking and dragging in the 
main graph window.  The point where the mouse is clicked will follow the 
mouse position while simultaneously holding the point in the lower left corner 
fixed.  A cross-hair, indicating the start of the zoom, appears where the mouse 
was first clicked and remains in the same location providing a reference to the 
current zero zoom point.  Moving the mouse back to the center of the cross-hair 
will effectively undo the current zoom.  The simplest way to zoom in on a 
feature of interest is to follow these steps: The two Zoom methods: 

1) Select Zoom, then 
click & drag. 
2) Resize the white box in 
the “mini-zoom” 
window. 

1) Move the region of interest into the lower left corner of the graph using one 
of the panning methods (§5.3).  Double-clicking and dragging is probably 
the simplest method. 

2) Make sure the default mode for the graph is set to Zoom. 
3) Left click around the feature and drag the mouse toward the upper right 

corner of the graph until the desired view of the feature is achieved. 

5.2.2 “mini-zoom” Window 

To facilitate zooming in the main window, there is a “mini-zoom” 
window inset within each graph, which always shows the full scale view of the 
graph window, i.e. all graph data is displayed as if <Ctrl+A> had been pressed 
in the main window.  Within the “mini-zoom” window is a white box that shows 
the current portion of the graph being displayed in the main graph.  Note: when 
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the main window shows the full-scale view, the white box will be nearly 
invisible on the edge of the “mini-zoom” window.  When the box is selected, 
two cursors will appear on the lower left and upper right edges of the box, which 
can be dragged to resize it.  Since the area within the box corresponds to the 
display in the main graph, this has the effect of zooming in the main graph.  To 
make it easier to adjust the zoom, double-clicking on the “mini-zoom” window 
greatly expands the window size; double-clicking again will return the ”mini-
zoom” window to its original size. 

To drag the box, click 
near the diagonal line 
joining the upper right 
and lower left corner. 

5.3 Panning 
There are four methods to pan around the graph: 
1) Double-click the left mouse button and hold on the 2nd click.  Then drag the 

mouse and the graph will follow the mouse location. 
The four panning 
methods: 
1: Double click and 
hold; 
2: Single click in Pan 
mode; 
3: Drag an axis; and 
4: Drag the white area in 
the “mini-zoom” 
window. 

2) Set the default mode to Pan and then proceed to single click on whichever 
point you want centered within the graph window.  This form of panning 
will not allow you to move beyond the boundaries of the data currently 
contained in the graph. 

3) Each of the axes can be dragged with the mouse.  When the mouse moves 
over an axis, the pointer will turn to a hand.  While the left mouse is 
pressed, the axis will follow the mouse. 

4) The white box located in the “mini-zoom” window of every graph can be 
dragged to any point in the window.  This will reposition the view area such 
that the main window subtends the same region as the white box in the 
“mini-zoom” window. 

5.4 Axis Scaling Modes 

Both the x and y axes behave independently as data is being acquired or 
the view is manipulated via panning or zooming operations.  The following axis 
scaling modes are set using two drop down list boxes (one for each axis) located 
either in the upper or lower left of all graphs. 

5.4.1 Fixed Scale 

This mode will keep the axis limits fixed at their presently set values.  
Zooming and panning are forbidden while in fixed mode. Fixed auto scale mode is 

set for the y-axis when 
starting a new run.  The 
mode prior to starting 
the run is restored after 
the run is stopped. 

5.4.2 Fixed Auto Scale 

This mode automatically keeps the axis limits properly set such that the 
entire range of data (for that axis) is displayed.  Thus, as data is acquired during 
a run, the axis limits will grow to accommodate the data and zooming and 
panning are forbidden. 

5.4.3 Auto Scale 

This mode behaves similarly to the Fixed Auto Scale mode.  However, 
zooming and panning are allowed.  If a zoom or pan is performed while in auto 
scale mode, the mode will automatically change to Float Scale. Float scale mode allows 

arbitrary zooming and 
panning. 

5.4.4 Float Scale 

This mode acts similar to the Fixed Scale mode, except that zooming 
and panning are both allowed.  Thus, without user intervention, the scale 
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remains at a fixed value, even if the data exceed that value.  Invoking Pan or 
Zoom allows the scale to be changed arbitrarily. 

5.5 Linear and Logarithmic Display 

The y-axis of any graph can be set to either logarithmic or linear 
display.  At present, the x-axis can only be displayed as linear.  Note:  zooming 
and panning can become very sensitive when the y-axis is in logarithmic mode.  
It is often easier to use the linear display for selecting a viewing region and then 
switching the display to logarithmic. 

Zooming and panning 
can be very sensitve 
while using logarithmic 
display. 

5.6 Cursors 

Cursors allow you to measure a particular point in a graph or the 
differences between 2 points of a graph.  Each graph in Kepler can have at most 
2 cursors added to the display.  Information about the cursor position and 
difference between 2 cursors (if they are both visible) are displayed either in the 
upper or lower right corner of the graph. 

Cursors cannot be added 
to a graph if there is no 
data in the display. 

5.6.1 Adding a Cursor 
1) First right click on the graph and select either Place Cursor 1 or Place 

Cursor 2 from the popup menu. 
2) Then click on the graph where you want the cursor. 

Note that if any other action is performed after the first step (i.e. left or 
right clicking anywhere but in the graph display), then the add cursor action will 
be canceled and must be restarted. 

5/6
After selecting add 
cursor, right or left 
clicking anywhere but in 
the graph will cancel the 
add cursor action. 
5.6.2 Moving a Cursor 

The mouse pointer will change to a left-right arrow when moving over 
a cursor, indicating that the cursor is ready to be moved.  While the mouse 
pointer is changed, left-click and drag the cursor to the desired location.  
Alternatively, for fine adjustments to the cursor location, while the mouse 
pointer is changed, just left-click on the cursor, which changes the cursor color 
to to white indicating that it has been selected.  Now the arrow keys on the 
keyboard will move the cursor either left or right in single bin increments. 

Drag a cursor with the 
mouse or select it and 
use the keyboard arrow 
keys. 

5.6.3 Crosshair display 

The default cursor view is a simple vertical line.  In some cases, it is 
useful to have a crosshair that shows the vertical level as well as the horizontal 
position.  To change the cursor to a crosshair, right click on the cursor (when the 
pointer changes to left-right arrow) and select the Crosshair entry from the 
popup menu.  To return the cursor to its default display, select the same entry 
from the menu again. 

The crosshair cursor can 
be handy for comparing 
vertical levels of data in 
a graph. 

5.6.4 AutoROI function 
Save time by using the 
autoROI function to 
define reasonable 
regions of interest. 

This cursor function will automatically create a region of interest (ROI) 
based on the current cursor position.  Please refer to §6.2 for general information 
regarding ROIs and §6.2.3 for more details about the autoROI function. 
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5.6.5 Removing a cursor 

To remove a cursor from the plot: right click on the cursor and select 
Delete. 

5.7 Reference Data Sets 

Reference data sets, or reference sets, can be very useful for comparing 
data taken under one condition with data taken under slightly (or not so slightly) 
different conditions.  Reference sets in Kepler behave in a similar manner to 
digital oscilloscope references, storing data in memory and allowing you to 
recall the data at a later time.  Kepler also allows you to both save reference data 
sets to disk and load data from disk as a reference set.  The graphical display for 
all reference sets can be changed (color, line style, line width) to suit your 
preferences.  Each graph in Kepler has 4 associated reference sets into which 
you can copy the current data in the graph and store it in memory. 

Reference sets can be 
created from data in 
Kepler or from files on 
disk.  At any time a 
reference set can be 
saved to disk. 

5.7.1 Copy Graph Data to a Reference Set 

A reference set that has 
data in memory will have 
a checkmark by the 
appropriate number. 

To copy a graph’s data to a reference set, right-click on the graph to 
bring up the popup menu and select the Copy to ref menu.  Within this menu is 
a list of all 4 reference sets - pick one.  The data is now saved in the reference 
set that was selected and the entry of this menu will show a checkmark by the 
reference number. 

5.7.2 Display a Reference on the Graph 
The menu item of a 
reference set available 
for display or scaling is 
shown in bold face. 

To display a reference set on a graph, right-click on the graph and 
select the Display ref menu.  The references that are available will be displayed 
in black, while the ones with no stored reference set are grayed out.  Pick a black 
reference set and it will appear overlaid on the graph. 

5.7.3 Scale Reference Data, then Display 

A reference set can be scaled before being displayed by right clicking 
on the graph and selecting the Scale ref menu.  A dialog box (see Figure XX) 
will appear that allows you to determine how to scale the reference set.  If the 
[Scale To Area] checkbox is checked, then the reference data are scaled as 
follows:  each bin is multiplied by a constant that is the ratio of the total number 
of graph events in a selected number of bins to the total number of reference 
events in the same selected number of bins.  The selected number of bins can 
either be the whole graph or one of its ROI’s, as determined by the drop down 
list box next to the [Scale To Area] checkbox. 

If the [Scale To Area] checkbox is not checked, then a simple linear 
combination of the graph and reference data is displayed.  Each bin of the graph 
data is multiplied by the constant from the text box on the left of the dialog and 
added to the same bin number of the reference data times the constant from the 
text box located on the right of the dialog.  The values in the two constants can 
be negative allowing subtraction operations between the reference and the 
graph.  For removal purposes this new graph counts as the same reference set 

5/6
Scaling a reference to 
the area in the graph 
data is a good way to 
compare two sets of data 
taken with different run 
times and/or input count 
rates.
number that was just scaled; likewise, if the same reference set number is 
displayed again, the old scaled data will be lost. 
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5.7.4 Remove a Reference Set 

A reference set can be removed from the graph by right clicking on the 
graph and selecting the Remove ref menu.  Selecting the desired reference set 
from the list removes it from the graph display, but leaves it in memory for 
future display. 

5.7.5 Modifying a Reference’s Graphical Display 
References»Reference 1(2,3,4) 

Selecting either the menu item or the DAQExplorer entries, 
References»Reference 1(2,3,4), opens the “Reference Configuration” window, 
which allows you to modify each reference’s line color, width and style.  When 
the [Line Color] button is pressed a color selection box will appear; the line 
color can be set to any of the predefined colors or to a custom color.  Up to 16 
custom colors are allowed (located at the bottom of the color selection box) for 
use within Kepler.  The line style and width are selected with the drop down list 
box next to the appropriate label.  The larger the line width selected, the thicker 
the lines used for displaying reference sets.  Currently, any change to the 
graphical representation of a reference set will affect all sets of the same 
numeral in all graphs. 

Individual control of the 
graphical display of each 
graph’s references is 
planned for a future 
release of Kepler. 

5.7.6 Saving and Loading a Reference Set from Disk 
References»Reference 1(2,3,4) 

Clicking on either the menu item or the DAQExplorer entries, 
References»Reference 1(2,3,4), opens the “Reference Configuration” window, 
which allows you to load reference sets from disk and save them to disk.  On the 
right side of the “Reference Configuration” window is a drop down list box that 
lists all the reference sets currently stored in memory with the following names: A reference saved to disk 

can be loaded directly 
into the graphs and 
likewise any graph data 
previously saved to disk 
can be loaded into a 
reference. 

• Spectrum – graph from the spectrum display in the “Kepler” window 
• Oscilloscope – graph from the oscilloscope graph in “Oscilloscope” 

window 
• PowerFFT – graph from the power spectrum of the FFT in the 

“Oscilloscope” window 
• BLHistory – graph from the baseline history graph in the “Baseline 

Information” window 
• BLHistogram – graph from the baseline histogram graph in the ”Baseline 

Information” window 
To load a data file from disk, click on the [Load Ref] button and select the file 
to load.  If successful, the reference set will appear in the drop down list box and 
be accessible from the correct graph.  To save a reference set to file, first use the 
drop down list box to select the reference set and then click on the [Save Ref] 
button. 
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6 Spectrum Analysis 

6.1 Reading data from the module 
[Refresh] 

There are three times when spectrum and statistics for the current or 
last run are read from the module:  at the end of an auto update period (see 
§4.3), at the end of a run (either ended by you or the module), and when you 
press the [Refresh] button. 

6.2 Regions of Interest (ROIs) 

6.2.1 ROI Data Table 

Region of interest data are displayed in a table just below the spectrum 
graph in the “Kepler” window, see Figure 6.  Each ROI occupies a single row in 
the table and each column in the table shows different information about the 
ROI.  Note:  if the ROI table is not visible, the separator that divides the window 
between the spectrum display and the ROI table is set too low - find the 
separator (near the bottom of the screen below the spectrum) and drag it higher.  
All bold characters in the first row and the letters, ACT, in the first column 
identify the currently active ROI.   

If ROIs are not visible at 
the bottom of the “Kepler” 
window, locate the 
separator bar near the 
bottom of the window and 
drag it higher. 

6.2.2 Adding and Deleting ROIs Manually 
[Add ROI] 
[Delete ROI] 

A new ROI can be added to the table by clicking the [Add ROI] 
button, which adds a row to the bottom of the ROI data table and makes the new 
ROI the active one.  Likewise, the active ROI can be removed by clicking the 
[Delete ROI] button.  If there is no active ROI, the delete operation cannot be 
performed.  To select a new active ROI, click on the far left column of the 
desired ROI row in the ROI data table and that row will become the active ROI. 

Click the left column in the 
ROI data table to make a 
different ROI active. 

6.2.3 Adding ROIs with the AutoROI function 

A region of interest (ROI) can be defined based on an internal 
algorithm and the location of the cursor.  The algorithm first finds the nearest 
local maximum to the cursor position, which is used as the starting point for the 
algorithm.  The data are then searched both left and right till a ‘bottom’ is found 
(the data start rising again).  Taking 0.25 of the difference between the peak 

5/6
Please refer to §6.2 for 
general information 
regarding regions of 
interest (ROIs). 
Figure 6: Region of Interest (ROI) data from Kepler.  The buttons at the right are used to add, delete 
and calibrate ROIs. 
height and the ‘bottom’ sets the level used to define the ROI limits.  The first 
point to the left and right that fall below this level define the ROI limits. 
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The AutoROI function will act on the currently active ROI, please see 
§6.2 for details about the ROI section of Kepler.  If no ROI is active, then one is 
created and the results of the AutoROI are applied to this new ROI. 

6.2.4 Changing ROI boundaries 

You may want to change the boundaries of an ROI.  In particular, when 
a new ROI is added, it will initially have no settings for its lower and upper 
bounds.  Kepler has three methods of setting boundaries, all of which work only 
on the active ROI: 

There are 3 ways to set 
ROI limits: 
• AutoROI on a cursor 
• Default mode Create 

ROI 
• Move ROI Cursors 

1) Use the autoROI function associated with cursors (see §6.2.3 below). 

2) Set the graph to the create ROI default mode or hold the hotkey associated 
with creating ROIs as defined in Tools»Options, then click and drag the 
mouse over the desired region on the spectrum.  Once the limits have been 
initially set, the methods listed here can still be used to change the settings 
at a later time. 

3) If the active ROI has limits, a pair of cursors will bracket it in the spectrum 
window.  The mouse can be used to drag each cursor independently to a 
new position (the mouse pointer changes to a left-right arrow when this 
action can be performed).  Alternatively, you can single click a cursor to 
select it (it will change its color to white) and then use the left and right 
keyboard arrow keys to move the ROI boundary in single bin steps. 

Move the ROI’s cursors to 
change its boundaries. 

Direct editing of the lower and upper bounds in the ROI table is not currently 
possible, but will provide a fourth method in the next release of Kepler. 

6.3 Region of Interest Display Parameters 

Several columns in the ROI data table affect the display of the ROI in 
the spectrum graph. 

6.3.1 Active ROI 

The column on the far left (labeled with ROI) of the ROI table displays 
the characters, ACT, in the row of the ROI that is currently active. This row is 
also displayed with the bold typeface. 

6.3.2 Color 

Both the “Active ROI” and “Color” columns (2nd from left) always 
match the color used to display that row’s ROI.  Left clicking on the “Color” 
column (labeled with a C) (not necessarily the active ROI row) brings up a 
dialog box used to change the ROI’s color. 

6.3.3 Visible 

For visible and locked 
status, the background 
color of the column can 
be a quick indicator: 
Green is unlocked or 
visible. 
Red is locked or 
invisible. 

ROI’s in Kepler can be either visible or invisible.  To toggle this 
property, left click on the column labeled with V.  An invisible ROI will still 
report statistical information for the data that it covers. 
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6.3.4 Locked 

The upper and lower bounds for an ROI may be locked to fix their 
settings and prevent accidental changes.  Left clicking on the column labeled by 
L will toggle the ROI’s locked status. 

6.4 Region of Interest Statistics 

6.4.1 ROI Lower and Upper Bounds 

The columns labeled Lower and Upper display the ROI’s lower and 
upper boundaries. 

6.4.2 ROI Mean 

The mean of the ROI region can be displayed in two forms:  arithmetic 
mean (labeled Ari-Mean) and Gaussian mean (labeled Gau-Mean).  The 
arithmetic mean is a weighted average of all the points in the ROI while the 
Gaussian mean is the result of fitting a simple Gaussian (no background or 

6.

5/6
The ROI mean can be 
displayed as a simple 
weighted average or as 
the result of a Gaussian 
fit. 
multi-Gaussian peaks) to the data within the ROI.  Left clicking anywhere in the 
column will toggle its display between the two means. 

6.4.3 ROI FWHM 

The FWHM is always the 
result of a Gaussian fit, 
but can be displayed as 
an absolute value or as a 
percentage of the 
Gaussian mean. 

The full width at half maximum (FWHM) of the data within the ROI is 
displayed in the column labeled either Gau-FWHM or Gau-%FWHM.  In both 
cases the FWHM is found from a simple Gaussian fit to the data within the ROI. 
Gau-FWHM displays the absolute FWHM while Gau-%FWHM displays the 
FWHM as a percentage of the Gaussian mean.  Left clicking anywhere in the 
column will toggle the display between the two values. 

6.4.4 ROI OCR 

The OCR for each ROI is displayed in the column labeled OCR (see 
§4.6.4 for general information about OCR).  The displayed OCR is the number 
of events in the ROI divided by the real time. 

5 Other ROI Data 

6.5.1 Desired Peak Position 

Typically, a ROI covers a single peak in a spectrum whose energy has a 
known value.  The column labeled Desired stores this energy value, which can 
be used to calibrate the energy of the spectrum as discussed in §6.6. 

6.5.2 ROI Name 
Meaningful names for 
the ROIs can make it 
easy to reference them 
later in other parts of 
Kepler. 

Each ROI can be given a name as a reminder of what it subtends in the 
spectrum.  For example, the Kα peak of 55Fe might be given the name, Fe55 Ka.  
This name is also used when scaling reference sets for display in the spectrum 
(see §5.7.3). 
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6.6 Calibrating peaks 
[Calibrate] 

Initially, the peaks of spectral lines are unlikely to fall exactly at their 
known energies in the spectrum.  This problem is resolved by calibrating the 
module’s gain using a peak at a known energy (for x-ray detectors this is 
typically the 5.9 keV peak of a 55Fe source).  To calibrate the module: 

1) As discussed in §6.5.1, store this known energy value in the Desired 
column of the ROI table for the peak of interest. 

2) Be sure that the ROI that contains the calibration peak is the active ROI. 

3) Move the mouse over the [Calibrate] button - the background color of the 
desired column and active row should turn to green indicating that the 

6.

5/6
Filling in desired column 
values as ROIs are 
added to Kepler makes 
calibration much easier.  
All these values are 
saved in the Kepler GUI 
save files, so it only has 
to be done once. 
calibrate operation is ready to proceed. 

4) Press the [Calibrate] button, which will cause the gain of the module to be 
scaled by the ratio of the desired position to the Gaussian mean. 

5) Collect a new spectrum.  The peak should now appear closer to the desired 
peak position.  However, due to non-linearities in the module’s gain setting 
electronics, the peak will probably not be exactly at the requested position.  
In addition, the ROIs will probably not be exactly optimal anymore either. 

Several calibration 
passes may be required 
depending on the 
precision desired for the 
peak position and how 
far the calibration has to 
move the peak. 

6) Readjust the boundaries for the active ROI if necessary. 

7) Repeat until satisfied.  Be sure to collect adequate statistics so that the 
location of the peak is determined by the module’s gain and not by random 
fluctuations in the data.  If the module has been previously calibrated with 
the current detector and preamplifier, convergence should occur in only two 
or three repetitions of the calibration process.  

Note 1: If the module has never been calibrated before for a particular 
detector-preamplifier combination, the change in gain on the first calibration 
pass may be so large that the calibration peak jumps completely out of its ROI.  
Just reset the ROI on the peak and proceed.  When the calibration is complete, 
don’t forget to save an .INI file to record the values for this detector. 

Note 2:  if a run is currently active, the calibrate operation will display 
a prompt about stopping the run; the current run data will be lost by proceeding. 

7 Saving and Loading Spectra 
Saturn»Spectrum»Save Spectrum 
Saturn»Spectrum»Load Spectrum 
Saturn»File I/O»Save Spectrum 
Saturn»File I/O»Load Spectrum 

By saving your spectrum 
from runs, you can 
always return at a later 
time and perform any 
analysis available in 
Kepler. 

“Kepler”»Spectrum»Save Spectrum 
“Kepler”»Spectrum»Load Spectrum 
<F7> 
<F8> 

The spectrum data can be loaded from disk and saved to disk in an XIA 
specified text format (please contact XIA for details on the format).  The 
spectrum file can be reloaded into the spectrum window at a later time for 
offline analysis and printing.  All run parameters that affect analysis and 
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statistics are saved and restored with the spectrum data (e.g. peaking time, real 
time, etc…). 

6.8 Printing Spectra 
Saturn»Spectrum»Print Spectrum 
“Kepler”»Spectrum»Print Spectrum 
<F9> 

The current view (zoom level and logarithmic/linear scaling) in the 
spectrum display can be printed to the default printer.  It is not possible to 
change the printer destination using the current version of Kepler (This ability is 
planned for future versions). 
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7 Diagnostic Tools Available for the Saturn 

7.1 Oscilloscope and Fast Fourier Transform (FFT) 
Tools»Oscilloscope 
<Ctrl+F5> 
Saturn»Diagnostics»Oscilloscope 

The XIA modules can provide data that emulate the actions of a digital 
oscilloscope, shown in Figure 7.  This data is very useful for exploring problems 
with detector setups since it provides a direct view of the signal that the module 
sees coming from the preamplifier.  An FFT of the oscilloscope data is also 
provided to help track down sources of coherent noise.  Since the oscilloscope 
display is literally a view of the ADC output on the module, we refer to the 

5/6
The oscilloscope tool lets 
you take a peak at what 
the module sees.  It acts 
like a very simple digital 
oscilloscope looking at 
the detector signal inside 
the module (not the exact 
input signal). 
oscilloscope display as an ADC trace. 
Figure 7: The oscilloscope display in Kepler.  An ADC trace is displayed in the upper pane and the FFT of 
the same ADC trace is shown in the lower pane.
7.1.1 Acquiring ADC Trace 
[Acquire Trace] 
[Stop Acquire] 
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Any time a data-taking run is not active, a new ADC trace can be 
acquired by pressing the [Acquire Trace] button on the “Oscilloscope” 
window.  Since, under some conditions, the acquisition of the ADC trace can 
take a noticeable time, it is possible to interrupt the current ADC trace 
acquisition.  A minimum of one ADC trace must be taken, so Kepler may not 
respond immediately (see §7.1.2 for more details).  To stop the ADC acquisition 
run, press the same button that was used to start the acquisition. 

7.1.2 Time between Samples 

The time interval between the samples in the ADC trace display can be 
changed to provide a longer history.  The minimum setting is the time required 
for the module’s DSP to capture a value from its ADC (100/75 ns for a 
Saturn/Polaris module).  The value in the text box labeled Sample Time in the 
“Oscilloscope” windows sets the time between samples.  The length of the ADC 
trace from the module is limited to 8K samples, so the total time covered by the 
ADC trace is 8k times the selected sample time.  It is important to note that each 
captured value is only a single sample from the module’s ADC (as opposed, for 
example, to an average of the samples in the interval).  This has implications for 
how high frequency noise is aliased into the FFT.  If you wish to use the FFT for 
critical work, and these implications are not clear to you, we recommend 
referring to a text on Fourier Transform theory. 

The sample time acts like 
the time scale on a 
digital oscilloscope, 
changing the time delay 
between samples that are 
displayed in the trace. 

7.1.3 FFTs and Averaging 

For each ADC trace acquired, Kepler calculates a simple FFT and 
displays the power spectrum.  This is a very powerful method for detecting and 
eliminating sources of coherent noise such as radio stations or computer 
monitors in the vicinity of the detector.  To provide more detail in the FFT, 
Kepler allows multiple ADC traces to be acquired and averaged into a single 
FFT.  The value in the text box labeled Iterations in the “Oscilloscope” window 
changes the number of traces that are acquired.  If the chosen sample time and 
number of iterations takes too long, the acquisition can be interrupted at any 
time, however the current acquisition run must complete before control is 
returned to you.  After an aborted acquisition, any data shown in the 
“Oscilloscope” should not be trusted. 

The FFT of the trace 
helps you find coherent 
noise problems in your 
detector and electronics 
setup.  It can be an 
invaluable diagnostic 
tool in some situations. 7.1.4 Saving and Loading 

“Oscilloscope”»Graphs»Save Oscilloscope 
“Oscilloscope”»Graphs»Load Oscilloscope 
“Oscilloscope”»Graphs»Save FFT 
“Oscilloscope”»Graphs»Load FFT 

Both oscilloscope and FFT data can be saved to a file on disk at any 
time using the menu items in the “Oscilloscope” window. 

7.1.5 Printing 
“Oscilloscope”»Graphs»Print Oscilloscope 
“Oscilloscope”»Graphs»Print FFT 
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The oscilloscope and FFT graphs can be printed separately to the 
default printer.  A window will open asking for information regarding the 
conditions under which these data were taken (which will also be printed). 

7

5

Figure 8: The baseline history and histogram display in Kepler.  The left pane shows the baseline history 
and the right shows the histogram. 
.2 Baseline History and Histogram 
Tools»Baseline 
<Ctrl+F7> 
Saturn»Diagnostics»Baseline 

As noted in §4.1.1, the spectroscopy module determines the energy of 
pulses from the preamplifier by time averaging them using a trapezoidal shaping 
filter.  For each pulse, the peak value of the filter output is captured and 
corresponds to the energy of the event that produced the pulse. In order for this 
process to be accurate, the module must track the amplitude of the filter output 
when no pulses are being processed, which is called the filter’s baseline.  At 
times, noise or other events can cause the baseline samples captured by the 
module to be erroneous in unexpected ways, resulting in degraded energy 
resolution.  The diagnostic acquisition of baseline information may assist in 
clearing up problems of this sort.  Please refer to Figure 8 for a picture of the 
baseline diagnostics window. 

Baselines are integral to 
the energy measurement 
and their history can be 
very useful in tracking 
certain classes of 
hardware problems. 

7.2.1 Acquiring Baseline Data 
[Get History] 
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[Get Histogram] 

The module provides two kinds of baseline information: a time 
sequence (history) of baseline averages and a histogram of baseline 
measurements.  The baseline history is simply a list of past baseline averages 
calculated by the module, plotted in time.  The history plot is useful for 
investigating periodic or non-periodic events that disrupt the baseline correction 
process.  For example, if low energy pulses are not correctly detected (e.g. the 
trigger threshold is improperly set) then these pulses will distort the baseline, 
showing up as a jump followed by an exponential decay occurring after each 
undetected pulse. 

Since the baseline cut (discussed in §4.1.7) is applied before a baseline 
is added to the history, the baseline history does not contain all captured baseline 
values and may therefore artificially hide some classes of problems.  To address 
these problems, the module maintains a baseline histogram that contains many 
captured baseline values, which means more historical information than just the 
last few baselines reported by the history.  In particular, since the histogram 
does not apply the baseline cut to its entries, one can see both where the cut is 
applied and what kinds of events are falling outside the cut.  Bimodal baseline 
distributions, for example, are characteristic of periodic background noise. 

Histogram entries do not 
have the baseline cut 
applied. 

7.2.2 Gaussian Fitting of the Baseline Histogram 

To aid in diagnosing the health of the baseline measurement, a 
Gaussian fit is performed on the baseline histogram and the results are reported 
directly below the histogram.  The fit searches for the largest peak in the 
histogram and fits the region between half the height on either side of the peak, 
which can cause bad fit values if the distribution is not dominated by a single 
Gaussian peak (but if that is the case, the baseline has already done its job by 
showing a serious noise problem somewhere!). 

7.2.3 Saving and Loading 
“Baseline Information”»Graphs»Save History 
“Baseline Information”»Graphs»Load History 
“Baseline Information”»Graphs»Save Histogram 
“Baseline Information”»Graphs»Load Histogram 

Both baseline history and histogram data can be saved to a file on disk 
at any time using the menu items in the “Baseline Information” window. 

7.2.4 Printing 
“Baseline Information”»Graphs»Print History 
“Baseline Information”»Graphs»Print Histogram 

The baseline history and histogram graphs can be printed separately to 
the default printer.  A window will open asking for information regarding the 
conditions under which these data were taken (which will also be printed). 
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8 Advanced Tools 

8.1 DSP Parameter Editor 
Tools»DSP Parameters 
<Ctrl+F6> 
Saturn»Advanced»DSP 

All XIA modules contain a DSP at the heart of their operation and 
Kepler provides an interface for directly editing exposed DSP’s parameters, 
shown in Figure 9.  It can not be stressed strongly enough that the results of such 
changes can produce unforeseen results and should only be undertaken by 
experts or under direction from XIA personnel.  To refresh the values displayed 
in the “DSP Parameters” window to match the values on the module, simply 
press the [Read Params] button. 

Warning!  Changing 
these parameters is 
really risky if you don’t 
know what you are 
doing. 

5

Figure 9: The DSP parameter editor.  Only experts should access this window since arbitrarily changing 
DSP parameters can lead to unforeseen behavior of the module. 
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8.1.1 Numeric Base Display 

The numeric base for displaying the DSP parameters can be changed 
from decimal to hexadecimal using a drop down list box located at the top of the 
“DSP Parameters” window. 

8.1.2 Editing Parameters 

Red = Read-Only 
Green = Read-Write 

DSP parameters come in two flavors: read-only (displayed in red) and 
read-write (displayed in green).  As the names imply, Kepler can only modify 
read-write parameters.  In order to edit a parameter, simply click on the number 
to the right of the parameter name, change the value and press the <Return> 
key.  It is imperative that the <Return> key is pressed or the value will revert to 
its previous value (change is canceled).  The keyboard arrow keys can be used to 
navigate around the DSP parameter list. 

Use arrow keys to 
quickly navigate the DSP 
parameter list. 

8.1.3 Saving 
[Save Params] 

To save the DSP parameters and values to a file, press the [Save 
Params] button and choose a filename and location.  The file is stored in a 
simple name-value text format.  To assist in debugging of some problems, XIA 
personnel use these files as system snapshots. 

8.2 Handel Error File 
Tools»Hardware Errors 
<Ctrl+F8> 
Saturn»Advanced»Hardware Errors 

All communication with the XIA modules is facilitated through a C 
software library called Handel.  For debugging purposes, Kepler provides an 
interface to Handel’s error reporting routines, shown in Figure 10.  Hopefully 
this will never be used, but there may be cases where the error file produced by 
Handel should be sent to XIA to aid in diagnosing problems.  The on screen 
display of the error file can be updated at any time using the [Read] button 
located on the “Error Reporting” window. 

8.2.1 Enabling Output 

The Handel error reporting can be turned on or off using the checkbox 
in the upper left corner of the “Error Reporting” window.  The error information 
is piped to a file on the disk of the host computer, which is determined, by 
default, using the setting of an entry in Tools»Options (see §2.6).  This file can 
be overridden by either clicking on the file selection button near the top of the 
“Error Reporting” window or by directly entering a new file in the text box also 
located at the top of the window. 

The main location of the 
Handel error file is 
stored in the windows 
registry and is accessible 
from the panel accessed 
with the Tools»Options 
menu item. 

8.2.2 Reporting Levels 
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The Handel library can report errors of different severity: debug, 
informational, warning and error.  Each error level is more serious to the 
continued running of Handel but only errors are critical to the continued 
operations of the XIA module.  The desired error reporting level can be set with 
the drop down list box located at the top of the “Error Reporting” window. 

Only messages reported 
at the error level are 
critical to the continued 
operation of Kepler. 

5

Figure 10: The error reporting window in Kepler.  This window echoes Handel errors within Kepler.  
Experts interpret the output displayed in this window to debug the performance of Kepler. 
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Appendices 

Appendix 1. Glossary 
DAQExplorer – refers to the tree of information and options along the left side of the “Kepler” main window 
module – refers to an XIA spectroscopy module 
host computer – refers to the computer on which Kepler is running 
Saturn – The XIA digital x-ray processor module. 
Polaris – The XIA digital γ-ray processor module. 
handel – A C library that is used by Kepler to perform I/O operations to all XIA modules.  Further details on Handel 

is available on the XIA website. 
DSP – digital signal processor.  A small processor used to perform calculations and other slow control tasks in the 

XIA modules. 
FPGA – field programmable gate array.  A FPGA is generally a re-programmable logic device.   
FIPPI – filter and pulse pile-up inspector.  In the XIA modules, the FIPPI is implemented in an FPGA and performs 

all real time operations in the XIA modules. 
EPP – enahanced parallel port.  EPP is the required communication protocol for the Saturn module. 
GUI – graphical user interface.  A term that generally refers to the graphical look and feel of the program.  When 

Kepler saves a GUI file, it is saving the graphical state of the program. 
INI – initialization.  This is a term that generally refers to an initialization file.  For Kepler, we refer to files that 

contain the hardware configuration as INI files. 
Spectrum – The data acquired during a run by the module.  This is also referred to as Multi-Channel Analyzer  

(MCA) data. 
FFT – Fast Fourier Transform.  A FFT is a Frequency space representation of data. 

Appendix 2. Command Short Cuts 
<F1> – Save GUI File 
<F2> – Load GUI File 
<F3> – Save INI File 
<F4> – Load INI File 
<F5> – Start/Stop Run (Toggle Run Status) 
<F7> – Save Spectrum 
<F8> – Load Spectrum 
<F9> – Print Spectrum 
<F12> – Open About Kepler Panel 
<Ctrl+F1> – Edit Reference 1 Properties 
<Ctrl+F2> – Edit Reference 2 Properties 
<Ctrl+F3> – Edit Reference 3 Properties 
<Ctrl+F4> – Edit Reference 4 Properties 
<Ctrl+F5> – Open Oscilloscope Panel 
<Ctrl+F6> – Open DSP Parameter Editor Panel 
<Ctrl+F7> – Open Baseline Panel 
<Ctrl+F8> – Open Handel Hardware Errors Panel 
<Ctrl+O> – Open the Options Panel 
<Ctrl+X> – Close Kepler (Without Saving) 
<Ctrl+I> – Open the INI File Organizer Panel 
<Ctrl+C> – Open the Detector Preamplifier Configuration Panel 
<Ctrl+R> – Toggle the resume run status 
 
When a graph is selected: 
<Ctrl+A> – Set the graph to full scale. 
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Appendix 3. EPP Port Requirements  

Kepler requires that the Saturn module be connected to a parallel port (usually LPT1) with an input/output 
range of either 0x278 or 0x378. 

Appendix 4. Common Problems 

Symptom Possible Cause Solution 

Handel error message:   

Epp port not found   

Firmware bad…;   

Error#1111   

Error #2222   

   

Gain related errors…   

   

   

   

Appendix 5. Index 
Axis Editing Parameters, 39 

Auto Scale, 24 Navigating Parameters, 39 
Fixed Auto Scale, 23 Numeric Base, 39 
Fixed Scale, 23 Parameter Colors, 39 
Float Scale, 24 Saving Parameters, 39 
Linear, 24 Error File, 39 
Logarithmic, 24 Enabling Output, 39 
Scale Modes, 23 Error Report Levels, 40 

Baseline, 35 File Location, 39 
FFT. See Oscilloscope Acquire Histogram, 36 

Acquire History, 36 Fields 
Guassian Fitting, 36 Selecting, 4 
Histogram, 35 Files 
History, 35 FDD Files, 9 
Load Histogram, 36 INI Files, 9 
Load History, 36 Gain Setting 
Printing, 37 Calibrating Peaks, 31 
Save Histogram, 36 Desired Peak Position, 30 
Save History, 36 Gain Setting Problems, 10 

Configuration, 10 Global Options, 7 
Loading an INI File, 10 Graphs 

Conventions, 2 Axis 
Cursors Auto Scale, 24 

Adding, 24 Fixed Auto Scale, 23 
AutoROI function, 25 Fixed Scale, 23 
Crosshair, 25 Float Scale, 24 
Moving, 24 Axis Scale Modes, 23 
Removing, 25 Cursors, see also Cursors, 24 

DSP Editor, 38 Default Modes, 21 
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Saving/Loading Files, 26 Linear, 24 
Scaling before Displaying, 26 Logarithmic, 24 

Related Manuals, 2 Mini-Zoom window, 22 
ROIs Panning, 23 

Active ROI, 29 Reference Data Sets, See also Reference Data Sets, 
25 Adding, 28 

Adding Automatically, 28 Zooming, 22 
AutoROI Function, 28 Zooming, Main Window, 22 
Bounds, 30 Zooming, Mini-Zoom Window, 22 
Color, 29 Hardware Requirements, 3 
Data Table, 28 Polaris, 3 
Deleting, 28 Saturn, 3 
Desired Peak Position, 30 Hardware Setup, 5 
Display Parameters, 29 Polaris, 5 
FWHM, 30 Saturn, 5 
Locking, 30 Help, 7 
Mean, 30 Items, Selecting, 4 
Moving ROI Boundaries, 29 Kepler 
Name, 31 Getting Around, 4 
OCR, 30 Load Files 
Visibility, 30 Histogram, 36 

Runs History, 36 
Dead Time, 20 INI Files, 10 
ICR, 19 Reference Data Sets, 26 
Input Count Rate, 19 Spectrum, 31 
Live Time, 19 Oscilloscope, 33 
OCR, 19 Acquire Trace, 33 
Output Count Rate, 19 FFT, 34 
Preset Run Types, 18 FFT Averaging, 34 
Preset Stop Value, 18 Load FFT, 34 
Real Time, 19 Load Oscilloscope, 34 
Resuming, 17 Printing, 35 
Run Events, 18 Sample Time, 34 
Run Time, 18 Save FFT, 34 
Run Times, 17 Save Oscilloscope, 34 
Run Types, 17 Preamplifier 
Starting, 16 Decay Time, 10 
Stopping, 16 Gain, 9 
Stopping Accuracy, 18 Parameters, 9 
Unavailable Functions, 20 Polarity, 9 
Update Interval, 17 RC Feedback Type, 10 
User Intervention, 18 Reset Interval, 10 

Save Files Reset Type, 10 
FFT, 34 Type, 10 
Histogram, 36 Printing 
History, 36 Baseline Histogram, 37 
INI Files, 9 Baseline History, 37 
Kepler, 6 FFT, 35 
Oscilloscope, 34 Oscilloscope, 35 
Reference Data Sets, 26 Spectrum, 32 
Saving DSP Parameters, 39 Reference Data Sets 
Spectrum, 31 Copy from Graph, 25 

Selecting Items/Fields, 4 Copying To, 25 
Settings, 13 Displaying, 25 

ADC Percent Rule, 15 Modify Display, 26 
Baseline Cut, 14 Removing, 26 
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Baseline Filter Length, 14 
Bin Width, 13 
Calibration Energy, 15 
Decay Time, 10 
Default, 7 
Detector Rise Time, 13 
Energy Threshold, 14 
Expert, 15 
Gap Time, 13 
Global, Options, 7 
Graphs, 7 
MCA Bins, 14 
Number of Bins, 14 
Peaking Time, 13 
Polarity, 9 
Preamplifier Gain, 9 
Preamplifier Type, 10 
RC Feedback Preamplifier, 10 
Reset Interval, 10 
Reset Preamplifier, 10 
Spectrum Bin Width, 13 
Spectrum Bins, 14 
Trigger Gap Time, 16 
Trigger Peaking Time, 16 
Trigger Rise Time, 16 
Trigger Threshold, 14 

Spectrum 
Printing, 32 

Reading from Module, 28 
ROIs, 28 
Saving/Loading Files, 31 

Spectrum Analysis, 28 
Starting 

Kepler, Program, 5 
Runs, 16 

Starting and Stopping Runs, 16 
Statistics 

Dead Time, 20 
ICR, 19 
Input Count Rate, 19 
Live Time, 19 
OCR, 19 
Output Count Rate, 19 
Real Time, 19 

Status 
Configured, 7 
Current GUI Save File, 8 
Current Save File, 8 
Program State, 7 
Run Active, 7 

Stopping 
Kepler, Program, 5 
Runs, 16 

Support, 3 
Window Tabs, 5 
Windows, Navigating/Moving Around, 4 

 

5/6/2003  Page   3  


	End Users License Agreement
	
	NOTICE TO USER:
	Use of the Software
	Restrictions
	Copyright
	DISCLAIMER OF WARRANTIES
	Limitation of Liability
	Governing Law and General Provisions
	Notice to U.S. Government End Users
	Verification of Compliance with Licenses
	Sample Programs


	Introduction
	Manual Conventions
	Related documentation
	Hardware Requirements
	Supported Spectroscopy Modules
	Saturn X-ray Spectrometer
	Polaris Gamma-ray Spectrometer

	System Requirements

	Support

	General Kepler
	Installation
	Getting Around Kepler
	Selecting Items and Moving Around Windows
	Window Tabs

	Hardware Setup
	Saturn Setup
	Polaris Setup

	Starting and Stopping Kepler
	Kepler save files
	Tools»Options Settings
	Help Displays
	Status Display
	Menus

	Configurations: Saving, Loading and Restarting
	INI files
	Firmware Definition Database (FDD) files
	Preamplifier Parameters
	Preamplifier Gain
	Preamplifier Polarity
	Preamplifier Type
	Reset Interval
	Decay Time

	Troubleshooting problems setting the initial gain
	Configuration methods
	Loading an INI file
	General Configuration


	Taking Data with Kepler
	Acquisition Values
	Peaking Time
	Gap Time
	Spectrum Bin Width
	Spectrum Bins
	Trigger Threshold
	Energy Threshold
	Baseline Cut
	Baseline Filter Length
	Expert Settings
	Calibration Energy
	ADC Percent Rule
	Trigger Peaking Time
	Trigger Gap Time


	Starting and Stopping Runs
	Resuming a run
	Update Interval
	Run Types and Times
	User Intervention
	Preset Runs
	Stop Control Value
	The Four Preset Modes
	Stop Accuracy

	Run Time/Run Events

	Run Related Statistical Information
	Real Time
	Live Time
	Input Count Rate (ICR)
	Output Count Rate (OCR) )
	Dead Time Percentage

	Unavailable functions while a run is active

	Graph usage in Kepler
	Default Modes
	Zooming
	Main Window Zooming
	“mini-zoom” Window

	Panning
	Axis Scaling Modes
	Fixed Scale
	Fixed Auto Scale
	Auto Scale
	Float Scale

	Linear and Logarithmic Display
	Cursors
	Adding a Cursor
	Moving a Cursor
	Crosshair display
	AutoROI function
	Removing a cursor

	Reference Data Sets
	Copy Graph Data to a Reference Set
	Display a Reference on the Graph
	Scale Reference Data, then Display
	Remove a Reference Set
	Modifying a Reference’s Graphical Display
	Saving and Loading a Reference Set from Disk


	Spectrum Analysis
	Reading data from the module
	Regions of Interest (ROIs)
	ROI Data Table
	Adding and Deleting ROIs Manually
	Adding ROIs with the AutoROI function
	Changing ROI boundaries

	Region of Interest Display Parameters
	Active ROI
	Color
	Visible
	Locked

	Region of Interest Statistics
	ROI Lower and Upper Bounds
	ROI Mean
	ROI FWHM
	ROI OCR

	Other ROI Data
	Desired Peak Position
	ROI Name

	Calibrating peaks
	Saving and Loading Spectra
	Printing Spectra

	Diagnostic Tools Available for the Saturn
	Oscilloscope and Fast Fourier Transform (FFT)
	Acquiring ADC Trace
	Time between Samples
	FFTs and Averaging
	Saving and Loading
	Printing

	Baseline History and Histogram
	Acquiring Baseline Data
	Gaussian Fitting of the Baseline Histogram
	Saving and Loading
	Printing


	Advanced Tools
	DSP Parameter Editor
	Numeric Base Display
	Editing Parameters
	Saving

	Handel Error File
	Enabling Output
	Reporting Levels


	Appendices
	Appendix 1. Glossary
	Appendix 2. Command Short Cuts
	Appendix 3. EPP Port Requirements
	Appendix 4. Common Problems
	Appendix 5. Index


